1 Introduction........................................................................................................................................ 1
  1.1 What Is the Backup Solution?........................................................................................................ 1
  1.2 Why Choose the Backup Solution?.................................................................................................. 2
  1.3 Concepts and Principles.................................................................................................................. 3
    1.3.1 Basic OBS Concepts.................................................................................................................. 3
    1.3.2 Backup Concepts...................................................................................................................... 4
    1.3.3 Highlights............................................................................................................................... 5

2 Quick Start...................................................................................................................................... 8
  2.1 Required Services........................................................................................................................ 9
  2.2 Data Planning............................................................................................................................... 9
  2.3 Process Description..................................................................................................................... 10
  2.4 Preparing Resources................................................................................................................... 11
  2.5 Installing Backup Software........................................................................................................ 12
  2.6 Configuring Interconnection Information................................................................................... 13
  2.7 Creating Backup Storage............................................................................................................ 15
  2.8 Creating a Cloud Repository....................................................................................................... 16
  2.9 Creating a Global Deduplication Policy....................................................................................... 18
  2.10 Creating a Backup Storage Policy............................................................................................. 21
  2.11 Creating a Backup Policy............................................................................................................ 26
  2.12 Performing a Backup................................................................................................................ 35
  2.13 (If Required) Performing a Recovery......................................................................................... 37

3 More Resources............................................................................................................................ 45
  3.1 Related Operations....................................................................................................................... 45
    3.1.1 Opening the Backup Software............................................................................................... 45
    3.1.2 Logging In to a Node Using PutTY....................................................................................... 46
  3.2 Documents................................................................................................................................... 47

A Change History............................................................................................................................. 49
1.1 What Is the Backup Solution?

Background

A good disaster recovery practice requires keeping usable business-critical backups offsite. Traditionally, organizations write backups to tapes and ship the tapes for offsite storage, which is costly and complex. In addition, the traditional method lays strict requirements for hardware, labors, and procedures to ensure that the offsite backups are up-to-date, secure, and easy to be recall and use when disasters occur. While shipping and securing storage is often outsourced, the IT organization of the enterprise faces the challenges of ensuring integrity of the backups and procedures.

The pricing and operational characteristics of cloud storage make it a compelling alternative of shipping tapes offsite. Cloud storage offers pay-as-you-use and elastic self-provisioning, with low prices per unit storage per unit time, making costs easy to predict, control, and map to the workloads of an organization's IT assets. Good cloud infrastructure provides storage redundancy, security, availability, and scalability through geographically distributed deployment, thereby ensuring minimal or even zero loss of data in the event of disasters and failures.

These characteristics make cloud storage an excellent alternative of shipping and storing tapes in a secure location. In addition, backups are created and updated over the network, drastically simplifying operational procedures with minimal or even no manual intervention.

Solution Overview

Deployed in a distributed architecture, the Backup Solution applies to users who have complex networks, and a large amount of data to be backed up, through various backup services. The solution uses Commvault as the backup software. In addition, the solution uses the backup management node to centrally manage data centers and branches and schedule backup tasks, notably simplifying backup system operations and enabling users to centrally manage backup systems. External Open Telekom Cloud (OTC) Object Storage Service (OBS) works as backup media to provide a strong guarantee for the exploding backup data.
The Backup Solution includes the following four components: backup client, backup server, media server, and backup storage.

- **Backup client**
  Obtains data to be backed up from production servers after being deployed on the production servers.

- **Backup server**
  Issues global backup policies and schedules backup services.

- **Media server**
  Writes data to backup media, and reads data from backup media for data recovery.

- **Backup storage**
  Stores backup data. This solution uses OTC OBS as backup storage.

### 1.2 Why Choose the Backup Solution?

For enterprises, this solution is the ideal choice for backing up critical data and archiving images, audio or video materials, logs, and so on.

Commvault is a leading backup and recovery software vendor that OTC has partnered with to enable application backup to OBS on OTC.

Commvault software provides simple failover management for all your critical enterprise applications, including SAP HANA, Oracle E-Business Suite, Microsoft Exchange, Microsoft SharePoint, Microsoft Active Directory, and Google Apps for Work. With Commvault, you can ensure availability and integrate business applications into your backup and recovery process.

OBS REST APIs enable applications to store and retrieve any amount of data from anywhere on the Internet. Sending backups over the Internet to be stored in the cloud benefits from the elasticity in capacity and operational expenses typical of cloud services. It can also simplify your own infrastructure as you no longer need to provide and manage storage (for example, tapes that need to be rotated or shipped away).
OBS is a persistent, extensible, and safe solution for backing up and archiving users' critical data. Its versioning function further protects data. Its high-durability and secure infrastructure aim to provide an advanced data protection and disaster recovery solution.

1.3 Concepts and Principles

1.3.1 Basic OBS Concepts

This section describes concepts related to OBS, including the object, bucket, Access Key ID (AK), and Secret Access Key (SK).

Object

An object is a basic data unit of OBS. It contains both data and metadata. Data uploaded to OBS is stored into buckets as objects.

For details about objects, see section 1.3.1 "Object" in the Object Storage Service User Guide.

Bucket

A bucket is a virtual container used to store objects on OBS. OBS provides flat storage methods based on buckets and objects. All objects in a bucket are at the same logical layer, eliminating the multi-layer directory structure of file systems.

Figure 1-1 illustrates the relationship between objects and buckets.

Figure 1-1 Relationship between objects and buckets

For details about buckets, see section 1.3.2 "Bucket" in the Object Storage Service User Guide.

AK and SK

A user's account provided by OBS contains an AK and an SK. The AK and SK are used for user identity authentication.
After subscribing to OBS, you can log in to My Credential and create AKs and SKs based on site requirements. The system identifies users who access the system by AKs, and SKs are used for key authentication. For details about objects, see section 3.2.3 "Creating Access Keys (AKs and SKs)" in the Object Storage Service User Guide.

- One AK maps to only one user but one user can have multiple AKs.
- One SK maps to one AK, forming a key pair for accessing OBS and thereby ensuring access security.

### 1.3.2 Backup Concepts

This section describes key concepts related to Commvault, including data backup, backup storage, data deduplication, and policy management.

#### Data Backup

Backup jobs are usually set to execute at specific intervals. Generally, there are three backup types:

- **Full backup**
  A full backup backs up all of the data that is specified in the backup selection list for the policy. If a full backup is used, only the latest full backup copy is required for restoring data. Usually, a full backup is executed during the initial backup.

- **Incremental backup**
  An incremental backup backs up only the data that has changed since the last full or incremental backup. If a full backup and an incremental backup are used, the latest full backup copy and all incremental backup copies are required for restoring data. The incremental backup of a database refers to the backup of logs.

- **Differential backup**
  A differential backup backs up only the data that has changed since the last full backup. If a full backup and a differential backup are used, the latest full backup copy and the latest differential backup copy are required for restoring the data.

#### Backup Storage

Backup storage is the back-end storage space used by the Commvault backup system. Common backup storage is as follows:

- **Disk storage**
  Backs up data to disks of storage systems.

- **CD-ROM storage**
  Backs up data to CD-ROM libraries.

- **Tape storage**
  Uses tape drives, autoloaders, or tape libraries to back up data.

- **Cloud storage**
  Uses S3, CIFS, or NFS interfaces to centrally back up data to cloud storage.

For backup storage in this solution, OTC provides the massive, secure, and reliable cloud storage service, that is, OBS.
Deduplication

Deduplication eliminates these extra copies by saving just one copy of the data and replacing the other copies with pointers that lead back to the original copies. When two or more files have the same content, deduplication segments the files and stores only one copy of each unique file segment.

Commvault employs block-level deduplication technology and uses SHA-512 (the most secure hash algorithm) to check whether duplicate blocks exist, providing an intelligent and efficient data storage method. The method identifies duplicate blocks and stores only one copy of the same data blocks on storage devices. When a data block is written into a storage device for the first time, the data block is physically written into the storage device. When the same data block is written into the storage device again, only one pointer is used to point to the existing data block in the storage device.

Policy Management

Policy management is critical to automated system operations. You can customize different policies to simplify deployment and standardize management. Commvault policy management involves the following policies:

- **Storage policy**
  
  Storage policies are used to manage storage devices. In storage policy management, you can create storage policies or global deduplication policies, modify storage policy properties, and view and modify associations between subclients and storage policies.

- **Plan policy**
  
  When the backup plans of multiple subclients are similar, you can create a plan policy to associate the subclients with the plan policy, facilitating large-scale deployment of backup jobs.

- **Subclient policy**
  
  When the backup contents of many subclients are the same, you can create a subclient policy, facilitating large-scale deployment of backup jobs.

1.3.3 Highlights

This section details highlights of the Backup Solution: reliable, secure, and easy to use.

Reliable

During data backup, the Backup Solution provides the following reliability guarantees from Commvault and OBS:

- Commvault provides multiple data protection mechanisms including full backup, incremental backup, manual backup, and automated backup by using backup policies, enabling comprehensive data protection.

- OBS is a reliable cloud storage service. When backup data is stored on OBS, multiple copies of data will be automatically stored in different disks. In addition, background checks for data consistency before and after storage will be performed and damaged data will be repaired in a timely manner.
Secure

The Backup Solution ensures data security from the following aspects:

- Commvault supports two encryption modes: encryption on the client side and on the MediaAgent side. In addition, it supports multiple encryption algorithms.
- Encrypted backup data can be transferred to OBS through HTTPS/SSL. OBS also supports encryption on the server side. Key Management Service (KMS) provides key management and the AES 256-bit symmetric key automatically encrypts users' static data that can be automatically decrypted in data downloads and retrievals.
- The OBS AK and SK authenticate identities of users who access OBS, and combine with Access Control Lists (ACLs) and bucket polices to implement access control, ensuring security of data transfer and access.
- OBS can store multiple versions of an object. You can quickly search for and restore the versions as well as restore data in the event of misoperations or application faults.
Easy to Use

After Commvault connects to OBS, users can easily complete data backup or restoration operations, monitor and control active jobs, and view events related to activities through the CommCell Console provided by Commvault.
Scenarios

Commvault is a leading backup and recovery software vendor that OTC has partnered with to enable SAP HANA application backup to OBS on OTC.

This scenario describes how to use the Backup Solution to back up SAP HANA deployed on the single node on OTC.

Deployed on Elastic Cloud Servers (ECSs) of OTC, SAP HANA is a high-performance real-time data computing platform based on the in-memory computing technology. Commvault software seamlessly integrates with SAP HANA and OBS to support backups of online databases and logs. When a fault or service migration occurs on the SAP HANA system, this solution can help you quickly and easily restore the system, thereby providing enterprise-level data protection for SAP HANA.

Logical Architecture

Table 2-1 describes each component in the logical architecture.
### Table 2-1 Component description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iDataAgent (iDA)</td>
<td>Commvault software provides iDataAgent that is deployed on SAP HANA production servers and obtains data to be backed up on the production servers.</td>
</tr>
<tr>
<td>CommServe</td>
<td>Commvault software provides CommServe that issues global backup policies and schedules backup services.</td>
</tr>
<tr>
<td>MediaAgent</td>
<td>Commvault software provides MediaAgent with a cloud storage connector that directly writes backup data to OBS.</td>
</tr>
<tr>
<td>Direct Connect</td>
<td>The Direct Connect service is one of the OTC network services to establish dedicated networks between enterprise data centers and OTC, which shortens the time of data transfer.</td>
</tr>
<tr>
<td>Object Storage Service</td>
<td>OBS is the backup media that stores backup data. It supports data encryption, lifecycle management, and versioning. OBS has different storage tiers for data backup.</td>
</tr>
<tr>
<td>Elastic Cloud Server</td>
<td>ECS is a virtual machine (VM) service on OTC. With the service, tenants can recover applications to new VMs on OTC for a testing purpose or an offsite recovery.</td>
</tr>
</tbody>
</table>

### 2.1 Required Services

In the scenario of backing up SAP HANA, Table 2-2 lists required cloud services.

#### Table 2-2 Required cloud services

<table>
<thead>
<tr>
<th>Cloud Service</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBS</td>
<td>OBS is the backup media that stores backup data. It supports data encryption, lifecycle management, and versioning. OBS has different storage tiers for data backup.</td>
</tr>
<tr>
<td>Direct Connect (optional)</td>
<td>The Direct Connect service is one of the OTC network services to establish dedicated networks between enterprise data centers and OTC, which shortens the time of data transfer.</td>
</tr>
<tr>
<td>ECS (optional)</td>
<td>Tenants can also restore SAP HANA applications into new ECS instances on OTC to perform an offsite recovery or for a testing purpose.</td>
</tr>
</tbody>
</table>

### 2.2 Data Planning

Table 2-3 lists data to be planned before SAP HANA is backed up.
Table 2-3 Data to be planned before SAP HANA is backed up

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>iDataAgent installation path</td>
<td>The iDataAgent backup client must be installed in the following path of the SAP HANA node:</td>
<td>/usr/sap/H00/SYS/global/hdb/opt</td>
</tr>
<tr>
<td></td>
<td>/usr/sap/SID/SYS/global/hdb/opt</td>
<td>NOTE</td>
</tr>
<tr>
<td></td>
<td>SID indicates the database instance name.</td>
<td></td>
</tr>
<tr>
<td>Communication port</td>
<td>After iDataAgent is installed, enable communication ports (8400 to 8403) between backup clients and the backup system on SAP HANA production servers' firewalls. This operation must be implemented by production server maintenance personnel.</td>
<td>-</td>
</tr>
</tbody>
</table>

2.3 Process Description

The following figure shows the process of backing up SAP HANA:

![Backup Process Diagram]

Table 2-4 describes each task in the process of backing up SAP HANA.
Table 2-4 Process description

<table>
<thead>
<tr>
<th>No.</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install backup software.</td>
<td>Install a complete set of backup software including CommServe, MediaAgent, and iDataAgent.</td>
</tr>
<tr>
<td>2</td>
<td>Configure interconnection information.</td>
<td>On SAP HANA, configure information for interconnecting SAP HANA and Commvault software.</td>
</tr>
<tr>
<td>3</td>
<td>Create backup storage.</td>
<td>Create a bucket on OBS as backup storage for SAP HANA.</td>
</tr>
<tr>
<td>4</td>
<td>Create a cloud repository.</td>
<td>Create a cloud repository on Commvault to interconnect with OBS.</td>
</tr>
<tr>
<td>5</td>
<td>Create a global deduplication policy.</td>
<td>Create a global deduplication policy on Commvault to enable storage policies with different storage periods to share one storage resource library so that data can be centrally deduplicated.</td>
</tr>
<tr>
<td>6</td>
<td>Create a backup storage policy.</td>
<td>Create a storage policy on Commvault based on users' data storage periods and configure features such as data deduplication, encryption, and compression in the storage policy.</td>
</tr>
<tr>
<td>7</td>
<td>Create a backup policy.</td>
<td>Create a backup policy on Commvault.</td>
</tr>
<tr>
<td>8</td>
<td>Perform a backup.</td>
<td>Back up SAP HANA on Commvault.</td>
</tr>
<tr>
<td>9</td>
<td>(If required) Perform a recovery.</td>
<td>Recover data on SAP HANA.</td>
</tr>
</tbody>
</table>

2.4 Preparing Resources

Software

Table 2-5 lists software required before SAP HANA is backed up.
Table 2-5 Software required before SAP HANA is backed up

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
<th>Download Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commvault software</td>
<td>Commvault software contains the following three components: CommServe (backup server), MediaAgent (backup media), and iDataAgent (backup client agent). CommServe is installed on the backup management node. MediaAgent is installed on the backup service node. SAP HANA iDataAgent is deployed on SAP HANA nodes.</td>
<td><a href="http://ma.commvault.com">http://ma.commvault.com</a></td>
</tr>
</tbody>
</table>

Tools

Table 2-6 lists tools required before SAP HANA is backed up.

Table 2-6 Tools required before SAP HANA is backed up

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
<th>Download Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>PuTTY</td>
<td>Cross-platform remote access tool, used to access nodes on Windows systems during software installation.</td>
<td><a href="http://putty.cs.utah.edu/">http://putty.cs.utah.edu/</a></td>
</tr>
<tr>
<td>WinSCP</td>
<td>Cross-platform file transfer tool, used to transfer files between Windows and Linux systems.</td>
<td><a href="http://winscp.net">http://winscp.net</a></td>
</tr>
</tbody>
</table>

2.5 Installing Backup Software

Scenarios

Commvault software contains the following three components: CommServe (backup server), MediaAgent (backup media), and iDataAgent (backup client agent). iDataAgent is deployed on SAP HANA nodes and seamlessly integrates with SAP HANA Studio. This section describes how to install a complete set of backup software.

Context

The Download Manager is an application that runs as an interactive wizard, similar to the installation package that was created from the application.

The CommCell Console is the graphical user interface (GUI) used to manage the CommCell environment, monitor and control active jobs, and view events related to activities.
Prerequisites

You have obtained the latest Download Manager from the Cloud Services website or the Maintenance Advantage website of Commvault. The application is supported on 32-bit and 64-bit Windows computers.

Procedure

For detailed operations, see https://documentation.commvault.com/commvault/v11/article.

Step 1  Install CommServe.
Use the installation package that was created from the Download Manager application to install the CommServe software on the backup management node.

Step 2  Install MediaAgent.
Use either the CommCell Console or the installation package that was created from the Download Manager application to install the MediaAgent on the backup service node.

Step 3  Install SAP HANA iDataAgent.
Use either the CommCell Console or the installation package that was created from the Download Manager application to install SAP HANA iDataAgent software on the backup client.

After installation, the link to executable Commvault Backint is available.

2.6 Configuring Interconnection Information

Scenarios

After the installation is complete, create the Backint for the SAP HANA parameter file (containing parameters for the Commvault SAP HANA agent) and the associated symbolic link from the SAP HANA side. In addition, on SAP HANA Studio, ensure that Backint is enabled and this backup method is configured for both data and log file backup.

Context

SAP HANA Studio is pre-installed on SAP HANA and is the tool most commonly used to back up and recover SAP HANA databases.

Prerequisites

- You have installed the backup software.
- The cross-platform remote access tool PuTTY is available.
- For the management node where SAP HANA resides, you have obtained its IP address, user name, and password.
You have obtained the administrator account used for logging in to SAP HANA Studio.

Procedure

**Step 1** Use PuTTY to log in to the SAP HANA management node.

**Step 2** On the host where you installed the SAP HANA Agent in the iDataAgent directory, create the SAP HANA BACKINT parameter file in the following format:

```
CvInstanceName
instance_name

CvClientName
client_name
```

**NOTE**

For the parameter file named `param`, place it under `/opt/commvault/iDataAgent`. It should be given read and write permissions (664).

For example:

```
$ . /opt/commvault/iDataAgent/param
```

**Step 3** Create the `/usr/sap/<SID>/SYS/global/hdb/opt/hdbconfig` directory.

**Step 4** On the command-line interface (CLI), type the following command to link the file to the specified location:

```
ln -s /opt/commvault/iDataAgent/param /usr/sap/<SID>/SYS/global/hdb/opt/hdbconfig/param
```

**Step 5** From the Windows Start menu, click All Programs.

**Step 6** From the list of programs, choose SAP HANA > SAP HANA Studio.

**Step 7** In the SAP Start Service Logon dialog box, type the administrator's user name and password.

**Step 8** In the SAP HANA Studio, set Backint Parameter File in the Data Backup and Log Backup areas to the file.
Step 9  In the Log Backup Settings area, select Backint for Destination Type.

2.7 Creating Backup Storage

Scenarios

On OTC OBS, create a bucket as the storage resource pool for backing up data and obtain the AK and SK for creating a cloud storage resource library.

Prerequisites

You have obtained the account for logging in to OBS Console.
Procedure

Step 1  Log in to OBS Console.

Step 2  Click Create Bucket in the upper left corner.

Step 3  In the Create Bucket dialog box, set Region and Bucket Name.

This example, Bucket Name is set to commvault.

Step 4  Click Create Now.

Step 5  In the upper right corner of the page, click the username and select My Credential to obtain the AK and SK.

2.8 Creating a Cloud Repository

Scenarios

On the CommCell Console, create a cloud repository using OBS as backup media.

Prerequisites

- You have logged in to the CommCell Console as an administrator.
- You have obtained the AK/SK access information for OBS registered users.

Procedure

Step 1  From the CommCell Console, in the navigation tree on the left, expand Storage Resources.
Step 2  Right-click Libraries, and choose Add > Cloud Storage Library from the shortcut menu.

![Cloud Storage Library Dialogue](image)

Step 3  On the General tab page in the Add Cloud Storage dialog box, type the following information:

- **Name**: Type the name of the cloud storage library.
- **Type**: Select Amazon S3.
- **MediaAgent**: Select the MediaAgent you want to use.
- **Access information**: Enter the credentials to access the cloud storage library.
  - **Service Host**: Enter obs.otc.t-systems.com.
  - **Access Key ID**: Enter the AK of an OBS registered user. For details about how to obtain the AK, see 2.7 Creating Backup Storage.
  - **Secret Access Key**: Enter the SK of an OBS registered user. For details about how to obtain the SK, see 2.7 Creating Backup Storage.
  - **Verify Secret Access Key**: Enter the SK of the OBS registered user again.
  - **Bucket**: Enter the created bucket name. For details about how to create an OBS bucket, see 2.7 Creating Backup Storage.
  - **Storage Class**: Select Standard.

**NOTE**

The following creates a cloud storage library named OTC_HANA_3 as an example.
Step 4  Click OK.

The new cloud storage library is displayed in the CommCell Console under Storage Resources > Libraries.

----End

2.9 Creating a Global Deduplication Policy

Scenarios

The global deduplication policy enables deduplication across multiple storage policies that use a common set of disk libraries and deduplication databases.

In addition, storage policies with different storage periods share one storage resource library so that data can be centrally deduplicated.

Prerequisites

You have logged in to the CommCell Console as an administrator.
**Procedure**

**Step 1** In the navigation tree on the left of the CommCell Browser, expand **Policies**.

**Step 2** Right-click **Storage Policies**, and choose **New Global Deduplication Policy** from the shortcut menu.

**Step 3** In the **Create Global Deduplication Policy Wizard** dialog box that is displayed, enter the global deduplication policy name (for example, **Global_Deduplication#hana4**) and click **Next**.

**Step 4** On the **Select the library** page, select the created cloud storage resource pool (**OTC_HANA**) and then click **Next**.
Step 5  On the Select a MediaAgent page, select a MediaAgent for the primary copy and then click Next.

Step 6  By default, only select Yes to enable deduplication for the primary copy and then click Next.
Step 7  Click **Browse** and select a path for storing deduplication databases (for example, **DDB_example**). Then click **Next**.

![Create Global Deduplication Policy Wizard](image)

**Step 8**  Confirm all configuration information and click **Finish** to finish creating a global deduplication policy.

----End

### 2.10 Creating a Backup Storage Policy

#### Scenarios

Create a storage policy for backup data according to the users' data storage period. This section describes how to create a storage policy of two full backups in 15 days as an example.

#### Prerequisites

You have logged in to the CommCell Console as an administrator.

#### Procedure

**Step 1**  From the navigation tree on the left, expand **Policies**. Right-click **Storage Policies** and choose **New Storage Policy** from the shortcut menu.
Step 2  In the dialog box that is displayed, select Data Protection and Archiving and click Next.

Step 3  Enter a storage policy name (for example, storage policy#hana4) and click Next.

Step 4  Select Yes, deselect Enable Client Side Deduplication, and click Next.
Step 5  Select a global deduplication policy and click Next.

Step 6  Enter the number of streams and retention criteria as needed.

- **Number of Device Streams**: specifies the number of device streams to be used during backup or restore operations for all the subclients that will use this storage policy. Set the number according to your actual needs. In this example, it is set to 100.

- **iDataAgent Backup data**: specifies the retention period for backup data. Enter the value according to your actual needs. In this example, the default values of 15 Days and 2 Cycles are retained. Values of 15 Days and 2 Cycles indicate that backup data is retained for at least 15 days and the backup data must contain two pieces of full backup data.
Step 7 Click Finish to start creating the storage policy.

The new storage policy is displayed under the Storage Policies node.

----End

Follow-Up Operations

After the storage policy has been created, enable the encryption and compression for this policy.

By default, encryption and compression features are not enabled for storage policies. You can perform the following operations to configure encryption and compression features for storage policies:

Step 1 From the navigation tree on the left, expand Policies > Storage Policies > storage policy#hana4. Right-click Primary and choose Properties from the shortcut menu.

Step 2 In the dialog box that is displayed, click the Advanced tab, select Encrypt Data, and set the following parameters:

- **Cipher**: specifies the encryption method. Set this parameter according to your actual needs. In this example, it is AES (Rijndael).
- **Key Length**: specifies the key length. Set this parameter according to your actual needs. In this example, it is 256.
Step 3 Choose Deduplication > Settings. On the Settings page, select Enable Software compression with Deduplication to enable a deduplication policy for compressing data.
Step 4  Click OK to complete the modification of the storage policy.

---End

2.11 Creating a Backup Policy

Scenarios

Before creating a backup policy, create a pseudo-client and a subclient. The operation sequence and their relationship are as follows:
### No.  Task                      Description

1.  Create a pseudo-client.  Create a pseudo-client and configure an instance to facilitate backups. Each instance references a SAP HANA database.

2.  Create a subclient.  Associate a storage policy with a subclient and perform client backups.

3.  Create a backup schedule.  Create a schedule to automatically execute the backup on a periodic basis.

### Prerequisites

- You have logged in to the CommCell Console as an administrator.
- You have created a backup storage policy. For details, see section **2.10 Creating a Backup Storage Policy**.

### Procedure

**Step 1** Create an SAP HANA client.

1. From the navigation tree on the left, right-click the **Client Computers** and choose **New Client > Application > SAP HANA** from the shortcut menu.

2. In the **Create SAP HANA Client** dialog box (the **General** page is displayed by default), set the following configurations:
   - In the **Pseudo-client Name** text box, type a name for the pseudo-client. The client name must be unique in the CommCell Console.
   - In the **Database Name** text box, type the name of the SAP HANA database (the SID).
   - In the **Number** text box, type the SAP HANA instance number.
   - In the **OS User Name** text box, type the admin user name.
   - In the **DB User Name** text box, type the user name that you use to access the SAP HANA database or use the hdbuserstore key.
- In the **Password** text box, type the password for the user name that you use to access the SAP HANA database.

3. On the **Details** tab page, click **Add** to add an SAP HANA instance to the pseudo-client.

4. On the **Storage Device** tab page:
   - From the **Command Line Backup** subtab, select a storage policy from the list used for command line backups.
- From the Log Backup subtab, select a storage policy from the list used for archive log backups.

- From the Data Transfer Option subtab, select a compression side as required. For example, select On MediaAgent to enable data compression on the MediaAgent.
From the Deduplication subtab, select a deduplication side as required. For example, select On MediaAgent to enable data deduplication on the MediaAgent.

5. On the General tab, in hdbsql location directory, enter the directory that contains the SAP HANA hdbsql tools. Generally, the directory is /usr/sap/<SID>/SYS/exe/hdb.
6. Click **OK**.

The new client appears in the CommCell Browser under **Client Computers**.

**Step 2** Create an SAP HANA subclient.

1. Expand the newly created SAP HANA client. Right-click a database instance, and choose **All Tasks > New Subclient** from the shortcut menu.

2. On the **General** tab, type a name in **Subclient Name**.
3. On the **Storage Device** tab:
   - From the **Data Storage Policy** subtab, select a storage policy from the list used for data backups.
   - From the **Data Transfer Option** subtab, select a compression side as required. For example, select **On MediaAgent** to enable data compression on the MediaAgent.
- From the **Deduplication** subtab, select a deduplication side as required. For example, select **On MediaAgent** to enable data deduplication on the MediaAgent.

4. Click **OK**.

    The **Backup Schedule** dialog box is displayed.

**Step 3** In the **Backup Schedule** dialog box, perform the following sub-steps to create a backup policy:

1. Click **Schedule** and then click **OK**.
2. In the Select Backup Type area, select **Full**. In the Job Initiation area, select **Schedule** and click **Configure**.

3. In the Schedule Details dialog box, select the appropriate scheduling options. For example:
   - Enter a schedule name.
   - Select **Weekly**.
   - Select the days you want to run the backup job.
   - Change **Start Time** to 9:00 PM.
4. Click **OK** to close the **Schedule Details** dialog box.

5. Click **OK** to close the **Backup Options** dialog box.

--- End

### 2.12 Performing a Backup

#### Scenarios

After a backup policy is configured, the system will automatically perform backup operations according to the backup policy. Alternatively, you can manually perform backup operations. This section describes how to manually back up SAP HANA on Commvault CommCell.

#### Prerequisites

You have logged in to the CommCell Console as an administrator.

#### Procedure

**Step 1** From the navigation tree on the left, expand **Client Computers** and click an SAP HANA client. Click the SAP HANA database instance to go to the instance page.

**Step 2** Right-click the newly created subclient and choose **Backup** from the shortcut menu.

The **Backup Options for Subclient** window is displayed.

**NOTE**

In this example, we use the created subclient **sap-hana-backup**.

**Step 3** In the **Select Backup Type** area, select **Full**, and in the **Job Initiation** area, select **Immediate**. Click **OK**.
Step 4  Click **Job Controller** in the upper left corner to view the backup progress.

---

### Related Operations

You can perform the following operations to view the backup execution records on CommCell Console:

**Step 1**  Log in to CommCell Browser as an administrator.

**Step 2**  From the navigation tree on the left, expand **Client Computers**. Right-click an SAP HANA client and choose **View > Job History**.

The **Job History Filter** dialog box is displayed.
Step 3  In the Job History Filter dialog box, select appropriate settings.

Step 4  Click OK.

The list of SAP HANA jobs is displayed under Data Management Job History.

2.13 (If Required) Performing a Recovery

Scenarios

This section describes how to recover data on SAP HANA source hosts.
NOTE
Before recovering data, you are advised to manually back it up to prevent data loss from a recovery failure.

Prerequisites
- You have logged in to the SAP HANA Studio as an administrator.
- At least one Completed backup record exists on the CommCell Console.

Procedure

Step 1  Right-click an SAP HANA database instance and choose Backup and Recovery > Recover System from the shortcut menu.

The Shut Down System dialog box is displayed.

Step 2  Click OK to restart the system.

After the system restarts, the Recovery of System dialog box is displayed.

Step 3  On the Specify Recovery Type page, select a recovery type according to your needs. For example, select Recover the database to its most recent state and click Next.
Step 4  On the Locate Log Backups page, specify the location(s) of log backup files to be used to recover the database. In Locations, enter the location where Backint is saved, click Add, and click Next.
Step 5  On the Select a Backup page, select a backup to recover the SAP HANA database.

1. In Backups, select one backup record.
2. Click Check Availability. If the status of Available is ✔, the backup records are available.
3. Click Next.
Step 6  On the Other Settings page, select Third-party Backup Tool (Backint), and then click Next.
Step 7  On the **Review Recovery Settings** page, confirm that recovery settings are correct, and then click **Finish** to start data recovery.

Step 8  If the following message is displayed, the data recovery is successful. Click **Close** to close the dialog box.
Step 9  On the **Overview** tab page, if **Operational Status** is **All Services started**, the system is recovered successfully and the database is running properly.
Related Operations

To check the result of data recovery on the CommCell Console, perform the following operations:

**Step 1** Log in to the CommCell Console as an administrator.

**Step 2** From the navigation tree on the left, expand Client Computers and click an SAP HANA client. Right-click a database instance and choose View > Restore History.

The Restore History Filter dialog box is displayed.

**Step 3** In the Restore History Filter dialog box, select appropriate settings.

**Step 4** Click OK.

The list of SAP HANA restoration jobs is displayed under Restore Job History.

---End
3.1 Related Operations

3.1.1 Opening the Backup Software

Scenarios

This section describes how to open the Commvault CommCell Console.

Prerequisites

You have obtained an administrator account for logging in to the CommCell Console.

Procedure

Step 1  Perform the following operations to open the CommCell Console:

- On computers running Windows 8 and Windows Server 2012:
  a. Click the Windows Start menu.
  b. From the list of programs, choose Commvault > Commvault CommCell Console.
- On computers running operating systems later than Windows 8 and Windows Server 2012:
  a. From the Windows Start menu, click All Programs.
  b. From the list of programs, choose Commvault > Commvault CommCell Console.

Step 2  In the Connect to CommCell dialog box, enter the user name and password of the administrator account.
Step 3  Click **OK** to log in to the CommCell Console.

---End

### 3.1.2 Logging In to a Node Using PuTTY

#### Scenarios

This section describes how to use PuTTY to log in to a node.

#### Prerequisites

- You have obtained PuTTY software, which is a cross-platform remote access tool.
- You have obtained the IP address, user name, and password of the node you want to log in to.

#### Procedure

**Step 1**  Double-click **PuTTY.exe**.

The **PuTTY Configuration** dialog box is displayed.

**Step 2**  In **Host Name (or IP address)**, enter the IP address of the node that you want to log in to.

**Step 3**  Click **Open**.

The PuTTY home page is displayed.

**NOTE**

- The **PuTTY Security Alert** dialog box is displayed upon the initial login to the VM. If you trust the website, click **Yes**. The PuTTY home page is displayed.
- If you enter an incorrect user name or password for five consecutive times upon the login to the VM, PuTTY will be disconnected and you need to connect to PuTTY again.

**Step 4**  On the right of **login as**, type the user name and press **Enter**.

**Step 5**  On the right of **Password**, type the password and press **Enter**.
When the host name of the node that you have logged in to is displayed on the left of the CLI prompt, the login is successful.

----End

### 3.2 Documents

This section introduces documents that may be used during backup solution implementation. These documents, covering Commvault, OBS, and SAP HANA, help familiarize users with the Backup Solution.

**Commvault Documents**

Commvault documents are listed at [https://documentation.commvault.com/commvault/v11/article?p=documentation.htm](https://documentation.commvault.com/commvault/v11/article?p=documentation.htm). You can view the documents by downloading them to your local computer. The procedure is as follows:

**Step 1** Enter [https://documentation.commvault.com/commvault/v11/article?p=documentation.htm](https://documentation.commvault.com/commvault/v11/article?p=documentation.htm) in the address box of a browser.

**Step 2** Click the icon on the right of the page.

**Step 3** From the navigation tree on the left, select a desired document and click Export to PDF. The Web Pages Export dialog box is displayed.

**Step 4** When Your PDF is ready for download is displayed, click Download PDF to download the document to the local computer.

----End

**OBS Documents**

For details about operations with OBS, refer to the *Object Storage Service User Guide*. You can view the documents by downloading them to your local computer. The procedure is as follows:

**Step 1** In the address box of a browser, enter [https://docs.otc.t-systems.com](https://docs.otc.t-systems.com).

**Step 2** In the Storage area, click Object Storage Service. The download page is displayed.

**Step 3** On the download page, click View PDF next to Object Storage Service User Guide.

----End

**SAP HANA Documents**

For details about operations with SAP HANA, refer to the *SAP HANA User Guide (Console)*. You can view the documents by downloading them to your local computer. The procedure is as follows:
Step 1  In the address box of a browser, enter https://docs.otc.t-systems.com.

Step 2  In the Solution area, click SAP HANA.

The download page is displayed.

Step 3  On the download page, click View PDF next to SAP HANA User Guide (Console).

----End
## Change History

<table>
<thead>
<tr>
<th>Release Date</th>
<th>What's New</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017-08-30</td>
<td>This issue is the first official release.</td>
</tr>
</tbody>
</table>